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1 Introduction

In order to obtain reliable turbulence statistics, as well as time-resolved particle image ve-

locimetry (PIV) measurements, one must be able to interrogate hundreds or even thousands

of PIV images within a reasonable amount of time(∼ a few hours). In the case or holographic

PIV (HPIV), interrogation speed is also a limitation because HPIV images can yields as many

as one-million vectors. Therefore, fast and accurate processing of PIV images is an absolute

necessity.

2 Fundamentals of PIV

Particle-image velocimetry is a technique that relies on the imaging of tracer particles embed-

ded within a flow at two distinct times, t1 and t2, to estimate the velocity of the fluid. The

images are generally recorded onto either film (photographic or holographic) or a CCD array.

Correlation analysis is used to extract the particle displacements, ∆X, and the first-order

velocity estimate

u =
∆X

∆t
, (1)

where ∆X is the average displacement of the particles in the fluid over the time interval

∆t = t2− t1 (Adrian, 1991). The t1 and t2 images can either be imaged onto the same frame

or onto separate frames (referred to as one-frame and two-frame PIV, respectively).

Typically, the image field is divided into small sub-domains referred to as interrogation

spots. Each of these sub-domains is then analyzed separately to obtain the velocity field

over the entire image. Strictly speaking, the spatial resolution of the PIV analysis is defined

by the size of the first interrogation spot, since one should not expect to resolve any scales

smaller than this. In order to obtain a valid velocity measurement, a spot should contain

anywhere from 7 to 10 particle pairs, where one pair refers to a particle imaged at both t1

and t2 (Keane and Adrian, 1992). An important point to keep in mind is that the velocity

of a particular interrogation spot is a function of the average displacement of the particles

in the spot.
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The average displacement of the particles in a particular interrogation spot is determined

by correlation analysis. The DC component of intensity in each spot is usually removed before

correlation, yielding the fluctuating intensity distribution. The correlation is then written as

R(s) =

∫
I1(X)I2(X + s)dX, (2)

where I1 and I2 represent the fluctuating intensity distributions of the first and second

interrogation spots, respectively. There are two types of correlation analysis that can be

used to determine the particle displacement. They are

• Auto-Correlation Analysis : Correlate an interrogation spot with itself (i.e. I1 = I2 =
I).

• Cross-Correlation Analysis : Correlate the first interrogation spot with a second spot
that is offset in the mean flow direction.

In auto-correlation analysis, the correlation result can be expressed in the form

Rauto = R+
D + R−

D + RS + RF , (3)

where RS represents the self-correlation between the spot and itself, RF is the inherent noise

in the correlation due to missing particle pairs, background noise, etc., and R+
D and R−

D

are the peaks representing the displacement of the particles over ∆t. Since the correlation

contains no information about which direction the particles are moving, i.e. from t1 to t2

or from t2 to t1, R+
D and R−

D are of equal height and in equal, but opposite, directions.

Because of this ambiguity, additional information is needed in order to determine the correct

correlation peak in auto-correlation analysis. Therefore, auto-correlation is not appropriate

for flows that contain reversal unless directional ambiguity techniques are utilized at the

time of image acquisition. These types of techniques impose a constant displacement to

the particle images taken at t2. This constant displacement is greater than or equal to the

magnitude of the flow reversal.

Cross-correlation analysis is a little more flexible than auto-correlation analysis. The

principle of cross-correlation analysis is to offset the second interrogation window by an
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amount roughly corresponding to the local displacement of the particles. This offset signifi-

cantly increases the probability of obtaining a valid correlation measurement between the t1

and t2 images. In one-frame cross-correlation (i.e. t1 and t2 images are imaged onto the same

frame), the correlation function is also given by (3). However, in this case, the magnitude of

the self-correlation peak is smaller than in auto-correlation analysis and the ‘true’ displace-

ment peak becomes larger than the ‘false’ correlation peak. Even so, it is still necessary to

know the mean flow direction a priori to make certain that the correct displacement peak is

chosen.

The second form of cross-correlation analysis is two-frame cross-correlation. This method-

ology is used when the t1 and t2 images are imaged onto separate frames. In this case, the

correlation result is expressed as

R2−fr = RD + RF . (4)

Since only a single displacement peak is obtained, two-frame cross-correlation analysis is ideal

for flows that have reversals, since no extra image shifting is necessary to resolve directional

ambiguities.

3 Software development

3.1 Motivation

As mentioned previously, in order to obtain reliable turbulence statistics, as well as time-

resolved PIV measurements, one must be able to interrogate hundreds or even thousands

of images within a reasonable amount of time. To this end, Meinhart (1994) designed a

parallel-processor-based interrogation system for photographic and holographic analysis that,

at peak performance, yielded nearly 100 vectors per second. Therefore, a 10,000-vector PIV

photograph could be analyzed in less than 2 minutes. The Meinhart system was constructed

around a Sun workstation that included eight Intel i860 array processors. It was interfaced

to a Videk Megaplus 1320 × 1035 pixel CCD camera with a Nikon 60-mm lens using an

Imaging Technology Model SI-150 frame grabber. This system would acquire a 1024× 1024
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pixel image and parse this image into eight 256× 256 pixel sub-regions. Each of these sub-

regions was then passed to a separate array processor for interrogation. In addition, the

computer controlled a translation stage through an Aerotech Unidex controller, that allowed

one to move through the entire area of a photograph or the 3-D domain of a holographic

image. In this way, the system was completely automated.

3.2 Current effort

Unfortunately, the array processors of this Sun-based interrogation system developed insur-

mountable difficulties. We were forced to assess the possibility of replacing it with another

system. The goal of this effort was to replace this workstation arrangement with a system

based upon a standard personal computer (PC). To that end, the new interrogation system

was constructed around a Windows NT workstation with dual Intel Pentium Pro processors

running at 200 MHz. Our software is called PIV Sleuth. The interrogation algorithm (see

Section 4) is implemented using Microsoft Visual C++ and IMSL math libraries. The sys-

tem can analyze both images stored on disk (digital PIV (DPIV)), as well as photographic

and holographic PIV images. For photographic and holographic PIV, a Bitflow Roadrunner

frame grabber is used to interface the same Videk Megaplus CCD camera with the new

host computer. The existing translation stage is controlled through RS-232 communications

with the Aerotech Unidex controller. A special set of libraries (freeware) is used to commu-

nicate through the serial port. Although some of the equipment is the same as was used

by Meinhart (1994), the interrogation software was independently written for the Windows

environment.

Currently, the software exists in two separate forms:

• A console application, which runs through a DOS window for photographic and holo-
graphic PIV interrogations (not including vector validation).

• A Windows-based application, which currently analyzes digitized images from disk
(including integrated vector validation) and contains the architecture necessary for
DPIV acquisition.

Vector validation was achieved by integrating existing software (Cleanvec written by Steven
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M. Soloff and Carl D. Meinhart) with PIV Sleuth. Figure 1 shows a screen-shot of the

Windows interface. All user-interface development was done by Soloff while all interrogation

development was performed by the author. The software is written so that it will run on

any machine running Windows 95/98 and NT. It is hardware-independent in the sense that

is not specially programmed for any type of processor, etc. In fact, it would simply have to

be recompiled to run on a DEC alpha machine, for example. The hardware independence

obviously does not include photographic and holographic interrogation since these tasks rely

on the Bitflow frame grabber and the Videk CCD camera.

3.3 Digital PIV

In digital PIV mode, the software reads images from disk. PIV Sleuth currently supports

the reading and writing of Bitmap (*.bmp), FLAT (*.img), and TIFF (*.tif) and the reading

of JPEG (*.jpg) image-file formats with a 256-color depth (8-bit images). The user specifies

the name(s) of the file(s) they wish to be interrogated. The files are read into memory and

passed on to the interrogation portion of the code. The software includes batch capabilities

that can handle approximately 2 billion images. The specifics of the interrogation algorithm

are discussed in Section 4.

3.4 Photographic and holographic PIV

For photographic and holographic PIV, the system is completely automated, just as with the

Meinhart system. The computer translates the photograph (for photographic PIV) or the

camera (for HPIV) via a translation stage. Once this motion ceases, the camera immediately

captures the necessary image(s). The timing of this sequence is determined by specifying

the speed at which the stepper motor operates. The time necessary to translate the specified

distance is then calculated and 250-ms is added to this amount to ensure that all motion

has ceased before image acquisition. The image is then passed to the interrogation portion

of the code, just as in DPIV. The interrogation process knows nothing about the source of

the image. In this way, the software is quite modular.
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One additional consideration in HPIV is that the computer must also control which

reference beam is illuminating the hologram, namely t1 or t2. Reference-beam control is

achieved by controlling the motion of two shutters on the reconstruction table through RS-

232 communication in concert with the image acquisition.

4 Interrogation algorithm

Once an image is either read from disk or transferred to memory by the frame grabber, it

is converted to a simple binary array representing the gray-scale value at each pixel. The

length of this array is equal to the number of pixels in the image and the ordering of the

image data is row-major. The interrogation of the image is actually quite simple. The steps

include:

1. Dividing the image into interrogation spots

2. Copying the interrogation spot to memory for analysis

3. Computing the correlation

4. Finding the displacement peak

5. Determining the displacement with sub-pixel accuracy

6. Repeating steps 2–5 until entire image is analyzed

In the coming sub-sections, each of these tasks is discussed in greater detail.

4.1 Defining the interrogation grid

In order to analyze the image, we must define a regular grid in the image plane upon which

we will compute the particle displacements. The grid spacing and number of gridpoints is

determined by the first interrogation spot size and the percent overlap of these spots. Note

that we allow variable-sized interrogation spots, including rectangular windows (i.e. the size

is not limited to simply the FFT size). We choose to create a “buffer” around the perimeter

of the image to prevent any of the t2 interrogation spots from leaving the domain of the

image. The buffer is minimized at each of the four borders such that the second spot is, at

worst, aligned with the edge of the image.
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4.2 Computing the spatial correlations

The correlation between the first and second interrogation spots is computed using fast-

Fourier transforms (FFTs). The IMSL FFT routines used here are optimized for array sizes

that are a product of small primes, so we choose to use standard array-buffer sizes of 16, 32,

64, 128, and 256 for the computation of the FFTs. If the interrogation-spot size is less than

the user-chosen FFT size, the data is centered in the FFT buffer and zero-padded around

the edges. (The ordering of the image information in the FFT buffers is column-major.) The

FFT of both spots is then calculated, and the cross-spectrum is computed via point-by-point

complex-conjugate multiplication of the two FFT results. The correlation is then formed by

computing the inverse FFT of the cross-spectrum. The FFT and inverse FFT calculations

‘swap’ quadrants (Qi), so the correlation data must be re-ordered. This re-ordering is quite

simple: Q1 ←→ Q3 and Q2 ←→ Q4.

4.3 Locating the displacement peak

In order to determine the mean displacement of the particles within an interrogation spot,

we must find the peak in the correlation plane corresponding to this displacement. There

are three situations of interest in determining the displacement peak:

• Auto-Correlation Analysis

• One-Frame Cross-Correlation Analysis

• Two-Frame Cross-Correlation Analysis

4.3.1 Autocorrelation analysis

In auto-correlation analysis, three distinct peaks exist in the correlation plane: the self-

correlation peak (RS), and two equi-height displacement peaks (R+
D and R−

D) that are in

equal but opposite spatial locations. The challenge now lies in determining which of these

three peaks is the true displacement peak. First, the self-correlation peak always resides

at the center of the correlation plane (0, 0). Therefore, we can simply remove this peak

by setting its values to zero. Once this is done, we still have to distinguish between the
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two displacement peaks. In order to do this, the user must provide information about the

direction of the mean flow in the field. This information is then used to distinguish between

the true displacement peak and the false displacement peak.

4.3.2 One-frame cross-correlation analysis

In one-frame cross-correlation analysis, three distinct peaks still exist in the correlation

plane: the self-correlation peak (RS), and two displacement peaks (R+
D and R−

D) that

are in equal but opposite directions. We know a priori that the self-correlation peak re-

sides at (−xoffset,−yoffset), so we can simply remove this peak by setting its values to zero

((−xoffset,−yoffset) refers to the horizontal and vertical interrogation-spot offsets used during

interrogation). Once this is done, we still have to distinguish between the two displacement

peaks. However, in this analysis case, the true displacement peak should be of greater mag-

nitude than the false peak. To be doubly sure that we have chosen the correct peak, we still

ask the user to provide information about the direction of the mean flow in the field. This

information is then used to distinguish between the true displacement peak and the false

displacement peak.

4.3.3 Two-frame cross-correlation analysis

Two-frame cross-correlation is the easiest correlation methodology to implement. There is

only one expected peak (RD), corresponding to the displacement of the particles in the

interrogation spot. In this case, the user need not provide information about the mean flow

direction.

4.4 Estimating the fractional (sub-pixel) displacement (ε)

The final task is to compute the sub-pixel displacement of the particles within the interroga-

tion spot from the correlation result. This is done by fitting a curve to the displacement peak

and finding the maximum of this curve. Specifically, this is accomplished by performing a

1-D fit in each direction, since the fractional displacements in each direction are statistically
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Figure 2: Idealization of displacement peak in one dimension.

orthogonal for small particle-image diameters (Westerweel, 1993). Figure 2 illustrates an

idealization of the points in the correlation plane used to determine the fractional displace-

ment. The choice of curve-fit depends on the quality of the particle images. If the particles

are relatively spherical and their images are free of distortion, then their intensity profile

should be roughly Gaussian, as should the displacement peak. In this case, a Gaussian curve

fit is the most appropriate choice. Otherwise, parabolic and centroid fits can also be used.

The Gaussian estimator can be written as

εG =
ln R−1 − ln R+1

2(ln R−1 − 2 ln R0 + ln R+1)
. (5)

The parabolic estimator is given by

εP =
R−1 −R+1

2(R−1 − 2R0 + R+1)
. (6)

Finally, the centroid estimator is

εC =
R+1 −R−1

R−1 + R0 + R+1

. (7)

The random error of these sub-pixel displacement estimators, ε, is given by

ε = cdτ , (8)
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where c is a constant between 0.05 and 0.10 and dτ is the mean diameter of the particle

images (Prasad et al., 1992). Therefore, the best we can expect to estimate the displacement

of the particles in a given field is to within 5–10% of their mean image diameters. This

error provides an excellent estimate of the experimental uncertainty associated with any

PIV measurement.

4.5 Second-order correlation

PIV Sleuth also includes a second-order correlation technique that allows one to increase

the effective spatial resolution without a loss of accuracy. This technique was developed by

Hart (1998). The principle behind it is quite simple: one correlates correlation planes of

adjacent interrogation spots in an effort to reduce the measurement noise and enhance the

displacement peak. Since the noise in the correlation should be random, there should be

no correlation between the noise in adjacent interrogation spots. The only correlation that

should exist is between the true displacement peaks. In effect, this technique increases the

signal-to-noise ratio of the measurement, allowing one to “shrink” the size of the interrogation

spots used for analysis. In second-order correlation, the vector is placed at the center of the

common region between the correlated areas.

4.6 Iterative cross-correlation

In situations where the mean displacement field is unknown a priori, or when there is no

mean flow present, an iterative interrogation procedure can be used to increase both the

quality and accuracy of the PIV measurement. The reasoning behind such an interrogation

procedure is quite simple: by offsetting the second interrogation spot by the local mean inte-

ger displacement, one can dramatically improve the accuracy of the correlation calculation.

Usually, use of the iterative cross-correlation procedure allows one to achieve an improve-

ment in spatial resolution. An initial interrogation is performed on a somewhat coarse grid

in order to determine the character of the mean flow. This displacement field is validated

and then used as a basis for the window offsets in a second, refined interrogation, usually
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on a finer grid. The fine grid is defined and the coarse-grid displacement results are inter-

polated onto the fine grid using a quadratic interpolation scheme. This interpolation defines

the offset of each interrogation spot in the fine grid. The spot offsets are still discrete (i.e.

to the nearest pixel); however, by offsetting each spot by the local mean integer displace-

ment one can dramatically increase the quality and accuracy of the PIV measurement. The

effectiveness of this correlation technique will be demonstrated in the next section.

5 Performance

5.1 Speed

The speed of PIV Sleuth was assessed on a computer with a single Pentium-II 450-MHz

processor and 256MB of RAM running Windows NT Workstation. Memory usage of PIV

Sleuth is relatively minimal (∼ 10 MB for a 1000×1000 pixel set of two-frame cross-correlation

images), so it can easily run on a PC with much less memory than the one used here. In

batch mode, the memory usage is the same as if one were analyzing a single set of images

because the software loads only the current image(s) into memory.

As far as processing speed is concerned, PIV Sleuth can compute 100 vectors/s using

64 × 64 FFTs (cross-correlation). This is comparable to the Meinhart Sun workstation

interrogation system. It is 30% faster in auto-correlation mode since one less FFT operation

is necessary. At this processing speed, a user can interrogate a 1000 × 1000 pixel image in

8.7 seconds. Therefore, an ensemble of, say, 1000 vector fields can be obtained in less than

2.5 hours. This efficiency makes statistically-convergent PIV ensembles quite realizable.

Additionally, a hologram containing one million vectors can be analyzed in 6 hours (using

64 × 64 FFTs) if overhead is neglected. (Overhead refers to moving the camera through

the field, data transfer from the camera to memory, registering views, etc.) With overhead

included, a single holographic analysis takes approximately 12 hours.

12



5.2 Accuracy

Accuracy is the singlemost important feature of any interrogation system. To assess the

accuracy of the system, simulated PIV images were created using PIVImage (a TSI, Inc.

software program). A known displacement field of uD = 8 pixels in x and vD = 4 pixels in

y was used to generate a particle-image field. The images were interrogated and the results

were compared with the specified displacement. Using 64 × 64 interrogation spots and an

offset equal to the displacement specified at creation of the images, the mean displacement

and RMS difference were found to be

µu = 7.9998 pixels; µv = 4.0061 pixels

(u− uD)RMS = 0.0537 pixels; (v − vD)RMS = 0.0537 pixels.

The accuracy of the sub-pixel estimator can be used to qualify this RMS difference. In the

simulated fields, the particle image diameter is 3 pixels, so, from (8), the error should be, at

least, 0.15 pixels. Our RMS difference between the given displacement and the calculated

displacement is on the order of 0.05 pixels, indicating that the sub-pixel estimator is working

as well as can be expected.

To test PIV Sleuth with a field containing velocity gradients, a set of simulated images

of a Gaussian vortex flow were used (courtesy of Center for Quantitative Visualization,

Caltech). This field should have a mean displacement of zero in both x and y. Using

32 × 32 interrogation spots and zero offset, along with a Gaussian sub-pixel estimator, the

displacement field was computed. The mean displacements over the entire field were found

to be

µu = −0.0047 pixels; µv = −0.0048 pixels.

Again, this is well within the random error of the sub-pixel estimator.
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5.3 Iterative cross-correlation

5.3.1 Simulated images

The simulated images of a Gaussian vortex flow discussed above were also used to illustrate

the effectiveness of the iterative cross-correlation procedure. Since this flow does not have a

mean flow direction, one cannot supply a single interrogation-spot offset for the entire field.

Therefore, a coarse-grid interrogation is performed using 32 × 32 interrogation spots with

50% overlap. This coarse-grid result was then validated and interpolated onto a fine grid

defined by 8 × 8 interrogation spots with 50% overlap. The results of the coarse-grid and

iterative interrogations are shown in Figure 3(a,b). The coarse-grid result is shown after

validation, while the fine-grid result is shown in pre-validation form. Figure 4 illustrates

the result of a single interrogation on a grid equivalent to that in Figure 3(b) using 8 × 8

first interrogation spots and 24 × 24 second interrogation spots before validation. Clearly,

comparing Figure 3(b) with Figure 4 illustrates the effectiveness of the iterative interrogation

procedure. The iterative interrogation procedure is quite effective in capturing the motion

of the flow even at the smallest resolvable scales.

5.3.2 Real images

To test the iterative cross-correlation procedure in a real experimental situation, we applied

it to images obtained in turbulent thermal convection. This flow is driven entirely by the

thermal instabilities present within the flow. Therefore, it does not contain a dominant mean

flow and is an excellent application (and test) of the iterative cross-correlation procedure.

Details of the experiment can be found in Fernandes (2000). The images are acquired using

a 1000× 1000 pixel CCD camera. The initial interrogation is performed using 32× 32 inter-

rogation spots with 50% overlap and zero offset. This field is validated and interpolated onto

a finer grid defined by 16 × 16 interrogation spots with 50% overlap, and the local integer

displacements found during the interpolation procedure are used to offset the second inter-

rogation spots. The coarse-grid and refined interrogation results are shown in Figure 5(a,b).

As with the velocity fields in Figure 3, the coarse-grid result is shown after validation while
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Figure 3: Iterative cross-correlation result for simulated images. (a) Course-grid result;
(b) Refined interrogation using the coarse-grid displacement field to define the window offset
field for the refined analysis.
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Figure 4: Single interrogation of simulated images from Figure 3 on a grid equivalent to that
of Figure 3(b).
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the refined result is presented in pre-validation form. A single interrogation of the images

using 16× 16 first interrogation windows and 32× 32 second interrogation windows is show

in Figure 6(c) before validation for a one-to-one comparison with Figure 5(b). Clearly, the

iterative procedure results in far fewer invalid measurements compared with the single inter-

rogation. Additionally, the time to perform the coarse- and fine-grid interrogations together

is equivalent to the time necessary for the single interrogation. Thus, iterative interrogation

provides a robust means of increasing the linear spatial resolution of the measurement by a

factor of 2 or more without a loss in computational speed.

6 Examples

PIV Sleuth has already been used by a number of people in their respective research pro-

grams. Tomkins and Adrian (1999) used its photographic PIV interrogation capabilities to

study the structures embedded within the zero-pressure-gradient turbulent boundary layer.

Figure 7 shows a typical realization from their work. This vector field contains 55,440 vectors

interrogated in approximately one hour on the Pentium Pro machine mentioned earlier. The

photograph was interrogated using one-frame cross-correlation with a larger second interro-

gation spot. This interrogation methodology increased the probability of finding a valid pair

for each particle in the first interrogation spot significantly (notwithstanding out-of-plane

motion of the particles between t1 and t2). A total of 1700 vectors were removed during

validation (3% of the total number). Nearly all of these were replaced successfully by choice

2 or choice 3 vectors, and by conservative interpolation.

Figure 8 shows an instantaneous velocity field obtained in the LTCF channel flow facility

(Christensen, 2001). The images were obtained by digital PIV (1000 × 1000 pixel images)

and were interrogated with PIV Sleuth. The PIV interrogation resulted in 19,012 vectors,

using 10-pixel × 20-pixel (height-to-width) interrogation spots with 50% overlap. During

validation, 2% of the Choice 1 vectors were removed; however, 80% of these holes were filled

with Choice 2 or Choice 3 vectors, while the remaining 20% of the invalid Choice 1 vectors

were conservatively interpolated. A constant convection velocity is removed from the field in
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Figure 5: Iterative cross-correlation result obtained in turbulent thermal convection.
(a) Course-grid result; (b) Refined interrogation using the coarse-grid displacement field
to define the window offset field for the refined analysis.
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Figure 6: Single interrogation for turbulent thermal convection images from Figure 5 on a
grid equivalent to that of Figure 5(b).
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Figure 8: Instantaneous channel flow vector field obtained by digital PIV and interrogated
with PIV Sleuth(Christensen, 2001). A constant convection velocity is removed from the
result to visualize the vortices embedded within the flow.
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order to visualize the vortical structures embedded within the flow. This example illustrates

how the use of rectangular interrogation windows can increase the spatial resolution of the

measurement in the inhomogeneous direction of the flow.

7 Instructions for using photographic and holographic

interrogation

As mentioned previously, the Windows-interface version of PIV Sleuth does not support

photographic and holographic interrogation. However, these tasks can be run from a DOS

window quite easily. The first step is to create a “parameters file”. This file includes the

following (each on a separate line):

• Number of horizontal pixels in image (integer): This is camera-specific (1024 for Videk
Megaplus)

• Number of vertical pixels in image (integer): This is camera-specific (1024 for Videk
Megaplus)

• Size of FFT to use (integer): either 16, 32, 64, 128, or 256 pixels

• Horizontal size of first interrogation spot (integer): Must be less than or equal to FFT
size (pixels)

• Vertical size of first interrogation spot (integer): Must be less than or equal to FFT
size (pixels)

• Horizontal size of second interrogation spot (integer): Must be less than or equal to
FFT size (pixels)

• Vertical size of second interrogation spot (integer): Must be less than or equal to FFT
size (pixels)

• Horizontal offset of second interrogation spot (integer): in pixels

• Vertical offset of second interrogation spot (integer): in pixels

• Horizontal size of image to interrogate (float): This is the horizontal size of photo or
holographic image (mm)

• Vertical size of image to interrogate (float): This is the vertical size of photo or holo-
graphic image (mm)

• Percent overlap of first interrogation spots (float): This should really be called fraction
of overlap because it is specified between 0 and 1
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• Pixels-per-mm (float): This is a calibration that tells the software how to convert from
pixels to physical units; it is obtained by calibration (see below)

• Interrogation mode (integer): 0 is auto-correlation, 1 is one-frame cross-correlation,
and 2 is two-frame cross-correlation

• Buffer size on left part of camera image (integer): This is specified so that the second
spot will not “fall” off the image (pixels)

• Buffer size on right part of camera image(integer): This is specified so that the second
spot will not “fall” off the image (pixels)

• Buffer size on top part of camera image(integer): This is specified so that the second
spot will not “fall” off the image (pixels)

• Buffer size on bottom part of camera image(integer): This is specified so that the
second spot will not “fall” off the image (pixels)

• Sub-Pixel Estimator (integer): 0 is Gaussian, 1 is parabolic, and 2 is centroid

• Flow direction (integer): 0 is up, 1 is down, 2 is left, and 3 is right (only used for
auto-correlation and one-frame cross-correlation, but it must always be specified)

• ∆t (float): in milliseconds

• Magnification (float): This is the magnification used when the photo or hologram was
recorded

Once this file is created, the user should put it in the same directory as the executable.

The next step is to calibrate the system to determine the conversion from pixels to

physical units (mm). This is done using a photo of vertical, alternating dark and light

lines that are 0.1911 mm thick. The user should place this photo in the photo-holder and

align it such that the lines are as vertical as possible in the camera frame. Then, the user

should run the executable and choose calibration. The code will prompt the user for the

spacing of the lines. Once this information is entered, it will compute the proper conversion

by interrogating the image. The code will then give the mean conversion along with the

standard deviation. If the standard deviation is too high (> 0.5%), one should repeat the

calibration (It is a good idea to double check the calibration value it gives by placing a ruler

in the field of view and roughly determining what 1024 pixels is in physical units).

The user is now ready to interrogate. The user should run the executable from a DOS

prompt. The code will ask for the name of the parameter file. Upon entering this information,
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the parameter file is read. The code displays the interrogation parameters in the DOS window

and asks the user to confirm these choices. If for some reason one of the parameters is not

satisfactory, the user should answer no and the executable will stop. The parameter file must

be edited accordingly and one must then start over.

Once the user is satisfied with the parameters they have chosen, a menu will pop up

with several choices. The only three of interest here are 2 (photographic interrogation), 3

(holographic interrogation), and 0 (exit). The user should select the appropriate choice for

their particular case.

If photographic interrogation is selected, the program will ask for a file name to which

the output will be written (this will be a standard, short-format (SRAW) file). The software

will then interrogate the entire photograph. Interrogation begins in the lower left corner of

the photograph and translates the photo from left to right and then vertically (in camera

coordinates), repeating until the entire domain specified by the user has been scanned. When

the code is done, the menu will pop up again. The user should choose 0 to exit or another

choice to perform another interrogation.

Holographic interrogation is a little different. Once the user selects this option, the code

will ask for a family name. The code then requests the number of planes in the depth

dimension that should be interrogated, along with the distance between these planes. For

each plane, it will append the plane number onto the family name to form the file name

for that plane. So, if one specifies ‘holo’ as the family name and they wish to interrogate

10 planes, one will have ten output files named ‘holo1.sraw’ through ‘holo10.sraw’. Once

this information is entered correctly, the software will proceed with the interrogation. The

camera translates just as in the photographic case, except that, after finishing a plane, it

also moves in the depth direction. When it is finished, the main menu will reappear.
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8 Instructions for using the windows application

8.1 Creating a new experiment

The Windows application is much easier to use than the console application. All operations

in PIV Sleuth are centered around an “experiment”. Every time one performs an actual PIV

experiment, a PIV Sleuth experiment should be created to process the data obtained. The

list below outlines the basic steps required to get started with a new experiment.

• Select New Experiment from the File menu.

• Select the type of experiment to be created, a base location for the experiment,
and the name of the experiment. Any files created by PIV Sleuth are placed in the
experiment directory specified.

• Select Add Files To Experiment from the Experiment menu (NOTE: this com-
mand can also be accessed by right-clicking the mouse on any folder in the experiment
workspace).

• Add one or more image files to the experiment.

• Select New from the File menu.

• Select the Configuration file type, make sure the Add To Experiment box is checked,
and enter a name for the file. This configuration file will serve as the default config-
uration file for the experiment, so an appropriate name might be “Default”. You can
also create a configuration file for each image (or set of images in the case of two-frame
CC). In this case, the configuration file name must be the same as the image (in the
case of two-frame CC, the same as the first image).

• Set the parameters for the interrogation method(s) to be used in the experiment and
save the configuration file (see below for further explanation).

• Select Settings from the Experiment menu.

• Select the Default Configuration File as the configuration file just created if a new
configuration file is not going to be created for each image (NOTE: one can also right-
click a configuration file in the experiment workspace and select the Set As Default
Configuration command).

When one creates a new configuration file, a dialog box will appear with three main

categories: General, PIV, and PTV. Additionally, under each of the main categories there

are sub-tabs. The General category includes the following items:
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• mean particle image diameter

• time separation between exposures (in ms)

• conversion from pixels to physical units (mm) in horizontal direction

• conversion from pixels to physical units (mm) in vertical direction

The PIV category includes four tabs: general, autocorrelation, one-frame cross-correlation

and two-frame cross-correlation. The choices are quite intuitive. The general tab includes:

• window (percent) overlap

• peak fit method

• mean flow direction

• option to use second-order correlation

• option to use iterative interrogation analysis

In auto-correlation mode, one must enter:

• FFT size

• interrogation spot size (horizontal)

• interrogation spot size (vertical)

• Advanced: (This is where one sets the image buffers)

For one-frame cross-correlation, the necessary parameters include:

• FFT size

• first interrogation spot size (horizontal)

• first interrogation spot size (vertical)

• second interrogation spot size (horizontal)

• second interrogation spot size (vertical)

• second interrogation spot offset (horizontal)

• second interrogation spot offset (vertical)

• Advanced: (This is where one set the image buffers)

The parameters for two-frame cross-correlation are:

• FFT size

• first interrogation spot size (horizontal)
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• first interrogation spot size (vertical)

• second interrogation spot size (horizontal)

• second interrogation spot size (vertical)

• second interrogation spot offset (horizontal)

• second interrogation spot offset (vertical)

• Advanced: (This is where one set the image buffers)

Finally, the PTV category is for future use.

One final note on the configuration file. The user can choose to use the second-order

correlation technique discussed earlier by checking the appropriate box in the configuration

file. Once the user appropriate choices are made, the user should save the file.

8.2 Interrogating images

8.2.1 Standard interrogation

Before interrogating an image, make sure the Interrogation Method and Interrogation

Mode (Whole Field is the only option currently available) have been properly set (see the

Tools menu). These two parameters are global to the entire experiment and are persistent

from session to session. Once these parameters are set, the user should open the image to

interrogate. This can be done by either using the Open command on the File menu or by

double-clicking an image file in the experiment workspace. Finally, select the Interrogate

command on the Tools menu.

If one is using two-frame cross-correlation, the two frames to be interrogated must be

selected. One can bypass the selection dialog box by using Frame Name Resolution (see the

Settings command on the Experiment menu). To use Frame Name Resolution, one must

also select the appropriate option on the Interrogation page in the options dialog box (see

Options on the Tools menu).

Each image is interrogated using a particular configuration file. PIV Sleuth first looks

for a configuration file whose name is the same as the image file (the first image frame in the

case of two-frame cross-correlation). If it cannot find one, it uses the default configuration
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file. This gives one the option of having a configuration file for each image in the experiment

or for a selected set of images. Most likely, though, one will use the default configuration

file for every image in the experiment.

When an image has been interrogated, the resulting raw vector file is added to the

experiment and has the same name as the image file (or the first image frame for two-frame

cross-correlation). This vector field can be overlaid on top of the image using the Overlay

command on the View menu.

If one prefers to use batch interrogation, one selects the Batch Interrogation command

on the Tools menu. Note that during batch mode, one must use Frame Name Resolution

for two-frame cross-correlation.

8.2.2 Iterative interrogation

An additional step is required to make use of the iterative interrogation capabilities of PIV

Sleuth. First, one interrogates their image(s) using the standard procedure outlined above

using a coarse grid (32 × 32 pixel interrogation spots, for example) which will capture the

large-scale motions. One then validates this field and should save the SRAW file (see below).

This validated field will serve as the basis for the offsets of the second interrogation. The

configuration file should then be opened and one should select the Iterative Interrogation

option in the General category. The fine interrogation grid should then be specified (16× 16

pixel interrogation spots, for example) in the PIV category. Finally, one should save the

configuration file and simply interrogate the image(s) using the Interrogate command.

Iterative interrogation can be used in batch mode. One simply must batch interrogate

the images with the coarse grid information, then batch validate to form an ensemble of

fields as a basis for the offsets of the second interrogation. One would then simply batch

interrogate using the fine grid information and the Iterative Interrogation option selected

in the configuration file.
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8.3 Validating vector fields

One begins by opening the raw vector field they wish to validate. Vector validation proceeds

in the exact manner as per CleanVec. To export a validated vector field, one uses the Export

Validated Field command on the File menu. When validating raw files in batch mode,

the validated field will be automatically exported when the Export active vector field

after validation box is checked.
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